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Important, please read this section!

This software is supplied as is without warranty or representation either express or implied with 
respect to the program or its documentation including their quality, performance, merchantability, or 
fitness for a particular purpose.

In no event will Oakley Data Services or any of its agents or assigns, or any organisation distributing 
SmartDate on its behalf be liable for direct, indirect, special, incidental, or consequential damages 
arising out of the use of, or inability to use the program.

All trademarks are acknowledged.
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What is Smartdate?
SmartDate is a diary/calendar/wallplanner application for Microsoft Windows 3.1.

Instead of running as a separate application which you have to start up, minimize and maximize and 
so on, SmartDate actually draws the calendar on the Windows Desktop and all operations are 
performed there. You never need to scrabble around looking for your calendar application, and by 
holding down the right mouse button on the control menu of any Window (in the top left corner) or on 
the desktop you will jump straight to Smartdate, and when you let go of the right mouse button your 
previous window layout will be automatically restored.

You can also use SmartDate a lot like a wallplanner, and can mark individual important dates with 
different colors, perhaps to indicate vacations and so on.

There is also a central area where you can load a bitmap of your choice (in the registered version) to 
customize your desktop, perhaps with a pretty girl or pictures of the family.

Features
SmartDate has a whole host of features, including:-

Setting the calendar font
Setting the calendar background color
Setting the colors for individual groups of dates
Specifying the central bitmap
Specifying the paper "texture" bitmap
Specifying the sound for each type of alarm
Accessing the calendar quickly, regardless of open windows on the screen
Making entries for a date
Reviewing entries for each date
Making "repeated entries" (i.e. every Friday at 11:00)
Causing an alarm to run another program
Automatically Running at Windows Startup
Using on a Network



The Menu Options
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Configuring SmartDate
You can change the fonts, colors and alarm sounds that SmartDate uses, and you can also put any 
bitmap of your own choice in the central "panel", or even have the central pictures chosen randomly 
for variety.

To access the menu for changing SmartDate's configuration, simply position the mouse-pointer over 
any part of the desktop calendar, hold down the left mouse button and click with the right mouse 
button and the menu will appear.

The Menu Options
Font
Allows you to select the font to use for the calendar from all those available on your system. Whilst 
you can change the point-size to enlarge the sample shown in the dialog box, SmartDate calculates 
the correct size of font to use to correctly fit the calendar on the screen, and will ignore your 
selection.

Colors
Background Color
Allows you to select any color for the background of the calendar.

Today Date Color
Specifies the color to use for "today". Note that this overrides any other color selection setting for this
day.

Color Group 0 ..... Color Group 7
Defines the color of each "color group". Each date can be assigned to a particular color group, and 
the date will display in the color defined for that group. If you subsequently redefine the color for that 
group all the dates in the group will also change color. The default color group for a date is group 0 
unless subsequently changed by the user.

Alarm Sounds
Alarm Type 1 Wav ... Alarm Type 8 Wav
Defines the *.WAV file that will accompany reminders set with the corresponding Alarm Type. A 
Standard file-navigation box is presented from which to select the *.WAV files. If your system cannot 
play *.WAV files then a simple beep will accompany any reminder.

Central Bitmap
Select Image...
This option allows you to choose any bitmap (*.BMP) to put in the centre of the calendar. A normal 
file-selection dialog is presented, and you can choose any image that your video card is capable of 
displaying. There is also the option to select images "randomly" from the same directory, and you can
also specify how often (in minutes) the image is randomly changed. Pictures of the family or pretty 
girls might be appropriate here. The registered version remembers your selection from run to run, the



shareware version does not.

Note that SmartDate makes no attempt to resize the image to fit. If the image is smaller than the 
central area, it will be centralized. If it is larger then that prtion that exceeds the right and lower 
boundaries of the central area will be clipped.

If you need to resize or otherwise manipulate graphics for the central area, an extremely good 
product is Paint-Shop Pro, from JASC. Inc.. Pain-Shop Pro is available from all ggod shareware 
sources.

Reset Color Palette
If you have a 256 color video subsystem, and there are two applications both trying to display a 
different set of 256 colors, something has to give. Windows attempts to mediate between the 
different applications that are running as best it can, but the poor old desktop always comes last in 
priority for choosing colors. Using this option can force SmartDate to realize the desktop palette and 
correctly display the colors in the selected bitmap. You will soon know if you need to use this option! 
See also the notes about conflicting colors under the section on choosing the calendar paper texture.

Clear
Resets the central image to the built-in logo.

Paper Texture
Select Bitmap...
Allows you to choose a bitmap to be repeatedly tiled across the background of each month of the 
calendar before the dates are overlayed, and tiled across any spare space in the central area.

Some bitmaps work very well as a background, usually those that are more of a "pattern" than an 
actual image. Images with strong geometrical repetitions may or may not work well, as the repetitions
may not always align perfectly as each month is built individually. The best thing to do is experiment!

Note also that color conflicts can again arise on palette-based (usually 256 color) displays. Priority is 
always given to the central image, and if the "Paper Texture" image has colors which are not 
components of the central image then those colors wll not always appear correctly.

Plain
Resets the calendar paper to a plain image without a bitmap, and colors it according to the 
specification of the "Background Color" in the "Colors" section of the menu.

Exit
Terminates SmartDate and replaces your Windows Desktop with whatever was there before 
(wallpaper or pattern etc.).

Quick Explanation
Presents a dialog box which explains in simple terms the operation of the mouse with SmartDate. 
There is a fuller explanation in the section

Using the mouse
Help
Jumps to this Help File.



About
Displays a standard "About" box.

Order Form
Jumps to an order form giving details of how to order (more) copies of SmartDate and giving local 
addresses and phone numbers.



Using the Mouse
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Understanding the action of the mouse is crucial to effective use of SmartDate. There are three main 
operations:-

Accessing the menu
To access the menu you have to be able to see a portion of the Windows desktop, with the 
SmartDate calendar on it. You then need to position the mouse pointer anywhere on the calendar, 
hold down the left mouse button, and click with the right mouse button. This can take a bit of getting 
used to and is worth practising.

Looking at the calendar and individual days
To see the complete calendar, either

1 Position the mouse-pointer over any visible portion of the calendar and press and hold down the 
right mouse button, or

2 Position the mouse-pointer over the control-menu of any window, and press and hold down the 
right mouse button. (The control menu is the dash to the left of the caption bar of the window, 
where the name of the window normally is).

All the windows currently on-screen will vanish, enabling you to see the complete calendar. The 
current day's events will appear in a window in the centre of the screen, and you can use the left 
mouse button to scroll up and down the list as usual. To move to another date simply click on the 
date you require with the left mouse button. Note that you must keep the right mouse button 
depressed during these operations.

When you release the right mouse button all the windows that were previously on-screen will re-
appear just as before.

Updating a particular day's entries
To update the entries for a particular day simply click on the day in question with the left mouse 
button, while holding down the SHIFT key. You may need to move some windows out of the way first 
to be able to see the day you require.

A dialog box will then appear from where you can make the entries you require. Use of the dialog box
is further explained in the section:-

Making Entries



Making Calendar Entries
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Accessing the Update Dialog
To access the Update Dialog simply click on the day in question with the left mouse button, while 
holding down the SHIFT key. You may need to move some windows out of the way first to be able to 
see the day you require.

The Update Dialog
The dialog box that is presented consists of two main sections. The top section has a listbox 
containing a slot for every fifteen minutes where you can add entries and specify reminders and 
alarms. The bottom section is a freeform entry box in which you can add notes particular to that day. 
Just below that is a drop-down list box which displays the color of each color-group, from where you 
can select the color you want the date to display in on the calendar.

Updating an interval
To add an entry for a particular interval, select that interval in the list box, and press the "Update 
Interval" button. The subsequent dialog box has the following options:-

Text
Type in the text you wish to appear in the list, and on the reminder that will appear at or after the 
specified time if you decide to have an alarm on this entry.

Issue as command
If you check this box then rather than a reminder appearing, the text will be assumed to be a 
command to be executed. You could use this for example to automate logons to an E-Mail service, or
perhaps to automate backups.

Note that the command will only be issued if you select an Alarm Type (see below), although the 
associated Wave file will not play.

Ignore if late
If you check this box then the alarm or command will only be issued if SmartDate is actually active 
during the relevant quarter hour period. If the box is not checked then any "missed" alarms or 
commands during the period when SmartDate wasn't running or the PC was switched off will be 
issued when SmartDate next starts.

Alarm
If left at <None> no reminder will be issued. Selecting any of the other 8 Alarm Type options will 
cause a reminder dialog to appear at the appropriate time, accompanied by the WAV file defined 
from the main menu for that Alarm Type.

Note that the WAV file doesn't sound if the "Issue as command" option is selected.

Repeat "n" times, once every ????



You can also specify that SmartDate add additional repeating entries based on your selections in 
these controls. You can add a maximum of 999 entries automatically this way, perhaps for example 
to enter a meeting always arranged for 16.00 on a Thursday afternoon.

Clearing an interval
Simply select the interval you want to clear and press the "Clear Interval" button. If the entry was in 
fact part of a repeated group you will be given the option to clear all the repeated entries as well.

Adding freeform notes
Simply type into the freeform text box.

Selecting the date color
Simply select the color you want from the drop-down list box.



Starting SmartDate Automatically
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You can cause SmartDate to run automatically every time you start Windows by simply putting an 
icon for it in the StartUp group in
Program manager.

One simple way of achieving this is by using "drag and drop" from the file manager. Follow these 
steps:-

1 Open the Program Manager, and open up the Startup group by double-clicking on it.
2 Start the Windows File Manager
3 Arrange Program Manager and File Manager so that you can see both on your screen.
4 In File Manager, navigate to the directory SmartDate is in (probably C:\SMARTDTE or similar) 

and locate the SMARTDTE.EXE file.
5 Position the mouse-pointer over the SMARTDTE.EXE file, depress and hold down the left 

mouse-button, drag the mouse to the Open Startup group in Program manager, and release the 
left mouse button.

You might like to print out these instructions before you try. You can do so by selecting the "Print 
Topic" entry from the "File" menu above.



Networking SmartDate
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Please note that to run SmartDate across a network (other than 
for evaluation purposes) you need a licence for the number of 
PC's that will be using SmartDate. A single copy licence does not 
entitle you to run SmartDate on more than one PC on a Network.
We can offer extremely attractive prices for multi-copy licences. Please contact us for details.
This version of Smartdate does not have any built-in network awareness, and problems will arise if 
you try to execute it from more than a single PC from a shared location.

SmartDate keeps its Calendar File (SMARTDTE.SCF) in the same location as the program was 
executed from. If multiple users execute the program from the same location they will use the same 
Calendar File, and this will cause data corruption and lost updates.

To prevent this, and share a single copy of the program, you can pass as a parameter the path 
where you want the Calendar File to reside when you execute SmartDate. Note that this option is 
only available in the registered version.

If you choose to signify an alternative location for the Calendar File you can either copy a valid 
Calendar File to that location, or you will get two error messages as SmartDate attempts to read a 
non-existent Calendar File and it's backup, after which SmartDate will automatically create a new, 
empty Calendar File.

Please contact us if you are interested in the Networking Version of SmartDate which allows 
data to be displayed simultaneously from both a common calendar, shared by all but updated 
by only one, and individual user calendars. This can make SmartDate the ideal tool to replace 
those holiday lists, meeting diaries and wallplanners that litter the modern office.



Backup
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Backing up your data is crucial.    If you have a problem and call us for help we may well ask you to 
restore your calendar file to the last good backup you have.

If you haven't got a backup we are unlikely to be able to help you!

Your calendar data is held in a file called SMARTDTE.SCF which will be in the same directory as the 
program. Please back it up regularly. If you don't adopt a regular backup routine perhaps now would 
be a good time to start.



Shareware
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This product is Shareware. Shareware is a form of software distribution, not free software. If you 
have not already registered this product, you have the right to evaluate it for a period of 30 days from
the date you initially install it. If you find that it suits your needs and you wish to continue to use it 
after the 30 day period you are required to register it by paying the registration fee to Oakley Data 
Services. There are significant advantages to registering your copy, not least the continued 
availability of good quality software at reasonable prices.

You also have the right, and in fact you are actively encouraged, to distribute copies of the 
Shareware version of this product. You may assume you have our authority to distribute this product 
unless we explicitly tell you otherwise. It must, however remain in its original, unmodified state, and 
all its constituent files must be included. No-one may charge for the program itself, although a 
reasonable fee for the media used and copying costs is allowable.

You may not distribute copies of the registered version of this 
product. You may not distribute the SMTDTE1X.DLL file in any 
form.

This software is supplied as is without warranty or representation either express or implied with 
respect to the program or its documentation including their quality, performance, merchantability, or 
fitness for a particular purpose.

In no event will Oakley Data Services or any of its agents, or assigns, or any organisation distributing
SmartDate on its behalf be liable for direct, indirect, special, incidental, or consequential damages 
arising out of the use of, or inability to use the program.

All trademarks are acknowledged.



Registering

Select the "Order Form" button on the reminder screen, or from the "Help" menu, for phone numbers 
and addresses.
You can register your copy of SmartDate by Phone, Fax, Mail or E-Mail. We accept cheques in 
Sterling, or VISA,Mastercard or American Express.

 If you have access to CompuServe you can also register via the SWREG Service and have the 
registration fee billed to your CompuServe Account. SmartDate's product Id is 3817.

We always ship the latest version of the product.

Printing an Order From
You can access an order form if you wish to register by Fax, Mail or E-Mail by pressing the 'Order 
Form' button on the reminder screen, or from the "Help" drop down menu. The order form shows the 
current registration fees and addresses and phone numbers.

Multiple Copy Licences
Registration of a single copy of SmartDate allows you to use it on a single PC, and to make back-up 
copies for security purposes. It does not permit installation on more than 1 PC at the same time, or 
use on multiple workstations connected to a network.

However, we do offer extremely attractive discounts for multiple-copy licences, allowing you to make SmartDate an integral 
part of your network, site or corporation. Please contact us for details.

Please let us know which version you currently have
If you register by phone, please let us know which version of the program you currently have (shown 
as R1.0 or similar on the program caption). This helps us greatly to determine how effective our 
shareware distribution methods are. If you use the order form the version number is already pre-
printed on it.



Custom Versions
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As you will have seen, SmartDate's central panel is the ideal place for an advertising message, 
corporate logo or other interesting image which you can keep in front of your friends, colleagues and 
customers on a permanent basis.

We can provide OEM or customised versions of SmartDate for you to use in your organisation, or for 
promotional purposes. These customised versions can also have the "Load Central Bitmap" option 
removed to ensure your message is on permanent display.

Please call for a quote for your requirements. Please note there is a minimum order of 100 units for 
customised versions.



Upgrade Policy and Getting Support
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Upgrade Policy
The code (.EXE file) for the registered and unregistered versions of the program are identical, and it 
is the presence of a file SMTDTE1X.DLL that is supplied with the registered version that causes the 
program to behave in a registered fashion. The presence of the DLL will also cause any further 
versions of SmartDate that still bear the 1.x release number to behave as registered versions, 
wherever you obtain them from. Versions that bear the 1.x release number will generally be for minor
enhancements and bug-fixes. Any release containing major new functionality will bear the release 
number 2.x, and an upgrade fee will probably be chargeable.

We will make new versions of SmartDate available via the usual sources, online on services such as 
CompuServe,CIX and the Internet and via disk vendors, cover disks and CD's.

The prime location for new releases is our support section on CompuServe, section 4 of the 
UKSHARE forum. The latest versions of all our products are available in Library 4.

If you do acquire a newer version of SmartDate simply ensure that the SMTDTE1X.DLL file you got 
when you registered is either in the directory that the SmartDate program is in, or is in your 
WINDOWS directory.

Getting Support
For support, please contact:-

Oakley Data Services,
3, Oakley Close,
Sandbach,
Cheshire CW11 9RQ
England.

Phone: (+44) (0)1270 759739
Fax: (+44) (0)1270 765272
CIS E-Mail: 74774,1347
Internet: 74774.1347@compuserve.com

Or contact us via our support section on CompuServe, Section 4 of the UKSHARE forum.



Order Form - SmartDate R1.0
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You can print this order form by using the "Print Topic" option from the "File" menu.

You will receive:-

· A copy of the latest registered version of SmartDate. Whilst we always try to ship as quickly as 
we can, by Air Mail if outside the UK, please allow 21 days for delivery.

· Shareware versions of some of our other software, including at least SmartCat Plus - the premier
Windows File Cataloger, Smart Address - a very sophisticated Address Book/Mailing List 
Manager, and SmartDoc - a Windows Help File printing/Text extraction utility, plus whatever else 
we have that will fit on the disk.

We can accept your order by mail, E-mail, Fax or Phone. Unless otherwise requested we ship a 3.5" 
disk.

We also offer considerable discounts for multi-copy licences for use across networks, across sites or across corporations. 
Please contact us for details on +44 (0)1270 759739.

Send your order to:-
Oakley Data Services,
3 Oakley Close,
Sandbach,
Cheshire CW11 9RQ,
England.

Please send me __ registered copy(s) of SmartDate.

Price :- £17.63 Pounds Sterling.
(In the EEC this is made up of 15.00 Pounds, plus VAT @17.5%, no charge for shipping. In the rest 
of the world this is made up of 15.00 Pounds, plus 2.63 Pounds Air-Mail Shipping + Handling).

(As of September 1994 the exchange rate was approximately 1.5 U.S. Dollars to 1.0 Pound Sterling. When we charge your 
credit card the card company will convert the cost to your local currency at the rate then prevailing and the sum will appear on 
your bill in your local currency.)

Total Price : .......................
I enclose a cheque / wish to pay by MasterCard / Visa / Amex (delete as applicable)

(Note: We can only accept cheques payable in the UK drawn in Sterling.)
Credit Card Details:-
Name as on card:-
Card Number:- 
Expiry Date:-



Please send the registered version to:-
Name:
Address:

Post/Zip Code:                                                Day Time Tel. No.

You can also contact us by:-
Phone:+44 (0)1270 759739; FAX: +44 (0)1270 765272; Compuserve: 74774,1347
Internet: 74774.1347@compuserve.com ,
or via Section 4 of the UKSHARE forum on Compuserve.

It would also help us if you could tell us where you got SmartDate from:-

And any suggestions you have for enhancements:-






